
BAB V

DASAR-DASAR ACTIONS SCRIPT

Bab ini akan membahas tentang dasar-dasar action script yang harus kita kuasi 

sebelum  kita  membuat  animasi  sederhana  menggunakan  action  script.  Biasanya 

bagian ini merupakan bagian yang sering dianggap sulit mengingat harus berurusan 

dengan  logika  pemrograman.  Akan  tetapi,  akan  terasa  lebih  asik  jika  kita  dapat 

membuat script hingga animasi yang kita buat sesuai dengan keinginan kita.

Variabel



BAB VI

MEMBUAT ANIMASI SEDERHANA DENGAN ACTIONS 
SCRIPT

Dalam  membuat  media  pembelajaran,  kita  tidak  lepas  dengan  penggunaan 

action  script.  Penggunaan  action  script  akan  membuat  file  media  kita  lebih  kecil, 

sehingga  loading  filenya  akan  lebih  cepat.  Pada  pasal  ini  kita  akan  mempelajari 

bagaimana mengenakan action script pada objek yang telah kita buat.

Membuat Animasi Benda Bergerak Linier

Untuk membuat animasi benda bergerak linier ke kanan, keiri ke atas atau ke 

bawah  sangat  mudah  untuk  ditangani.  Selengkapnya  marilah  kita  ikuti  langkah-

langkah berikut ini.

1. Buatlah lingkaran tanpa stroke dengan warna gradasi.

2. Ubahlah menjadi objek movie clips, caranya klik menu  Modify ->Convert to 

Symbol -> Movieclip.

3. Setelah objek kita sudah menjadi bentuk mvie clip, maka pilih objek tersebut 

kemudian aktifkan Actions.

4. Tuliskan beberapa scrip seperti yang ada di bawah ini



5. Hasilnya dapat dilihat dengan menekan ctrl + Enter

ULASAN

Apa yang telah kita buat tersebut berupa benda berbentuk bola ynag bergerak 

terus menerus ke arah sumbu-x. Setelah melewati pembatas bingkai kanan, ternyata 

benda tidak berhenti. Dengan action script kita dapat dengan mudah mengehntikan 

benda tersebut ketika sampai pada bingkai pembatas yang kita buat. 

Disamping itu, kita mengenalkan notasi _x sebagai property yang dimiliki oleh 

objek movie clip untuk sumbu x. Sedangkan, untuk property sumbu y objek memiliki 

notasi _y. Oleh sebab itu, apabila kita mengubah _x menjadi _y pada script di atas, 

maka benda akan bergerak ke atas. 

onClipEvent(load){
i=5;

}
onClipEvent(enterFrame){

_x=_x+i;
}

Pada  script  tersebut  kita  juga  mengenalkan  beberapa  perintah  seperti 

onClipEvent().  Perintah  onClipEvent(load) menyatakan  inisialisasi  objek,  artinya 

kitta memberikan nilai awal pada variable bernama I dengan harga 5.  Pada kasus ini, 



harga  i  menentukan  kecepatan  benda  bergerak.  Semakin  besar  harga  I  yang  kita 

berikan, maka akan semakin cepat pula gerakan benda.

Perintah onClipEvent(enterFrame) menyatakan perintah yang akan dijalankan 

berulang-ulang. Dengan kata lain, inti dari perintah objek kita berada di bagian ini. 

MEMBUAT  ANIMASI  GERAK  OBJEK  LINIER  DAN  BERHENTI  PADA  SAAT 

MENEMUI BINGKAI PEMBATAS

1. Buatlah lingkaran tanpa stroke dengan warna gradasi.

2. Ubahlah menjadi objek movie clips, caranya klik menu  Modify ->Convert to 

Symbol -> Movieclip.

3. Setelah objek kita sudah menjadi bentuk mvie clip, maka pilih objek tersebut 

kemudian aktifkan Actions.

4. Tuliskan beberapa scrip seperti yang ada di bawah ini

onClipEvent(load){
i=5;

}
onClipEvent(enterFrame){

_x=_x+i;
if (_x==550){

i=0;
}

}

Keterangan 



Script di atas bertujuan untuk menghentikan gerakan objek saat posisi objek 

berada pada sumbu x sejauh 550 pixel. Perhatikan pernyataan 

if (_x==550){
i=0;

}

memberikan kondisi bahwa jika benda sudah berada pada posisi x = 550 pixel, maka 

kecepatannya sama dengan nol yaitu i=0. 

MEMBUAT ANIMASI BENDA BERGERAK KEKIRI DAN KE KANAN.

Langkah-langkahnya antara lain:

1. Ikuti langkah1 hingga 3 pada trik sebelumnya.

2. Berikan script pada objek sebagai berikut.

onClipEvent(load){
i=10;

}
onClipEvent(enterFrame){

_x=_x+i;
if (_x>220 or _x<0){

i=-i;
}

}

Keterangan 

Script tersebut memprogram objek untuk bergerak ke kanan dank e kiri. Benda akan 

bergerak  ke  kanan hingga  posisi  benda berada  pada posisi  x=220  kemudian akan 

berbalik arah gerakan kea rah kiri hingga posisi x=0. Dari posisi x = 0, benda akan 

berbalik  arah  gerakan  kembali  kea  rah  kanan.  Hal  ini  dikondisikan  dengan 

pernyataan 



if (_x>220 or _x<0)

Membuat Objek Bergerak ke kanan dan ke kiri

Untuk membuat gerakan ke kanan dan ke kiri pada objek, maka ikuti langkah-

langkah berikut ini:

1. Buat objek, misalnya kotak dan ubah menjadi bentuk movieclip, caranya select all 

pada objek, kemudian pilih menu Modify > Convert to Symbol > movieclip.

2. Setelah objek menjadi simbol movieclip, kemudian berilah nama objek tersebut 

dengan kotak_mc. Select objek dan berilah script berikut

onClipEvent(load){

this._x=0;

}



onClipEvent(enterFrame){

this._x=this._x+10;

}

3. Perhatikan gerakan objek. Ternyata objek bergerak terus ke kanan dan tidak 

pernah kembali. Agar objek bergerak ke kanan dan ke kiri, maka kita perlu 

menambahkan script lagi seperti di bawah ini.

onClipEvent(load){

gerak="kanan";

}

onClipEvent(enterFrame){

if (gerak=="kanan"){

this._x+=10;

if (_x>700){

gerak="kiri";

}

}else {this._x-=10;

if (_x<-200){

gerak="kanan"}

}

}



atau dengan cara yang lebih mudah buatlah script seperti di bawah ini

onClipEvent(load){

n=10;

}

onClipEvent(enterFrame){

this._x+=n

if (this._x>550 or this._x<0){

n=-n;

}

}

4. Untuk dapat melihat pada posisi berapa objek berada pada saat itu, maka kita 

perlu menambahkan dynamic text di stage. Berilah nama dynamic text tersebut 

dengan posisi_x. Setelah itu tambahkan script seperti di bawah ini.

onClipEvent(load){

gerak="kanan";

_parent.posisi_x=this._x;

}

onClipEvent(enterFrame){

_parent.posisi_x=this._x;



if (gerak=="kanan"){

this._x+=10;

if (_x>700){

gerak="kiri";

}

}else {this._x-=10;

if (_x<-200){

gerak="kanan"}

}

}

Membuat Objek Terjebak dalam Kotak

Pada bagian ini kita akan membuat sebuah objek yang terjebak di dalam 

sebuah kotak, hingga tidak dapat keluar lagi. Untuk membuatnya ikuti langkah-

langkah berikut ini.

1. Buat layer 1 dan berinama kotak. Dalam layer ini buatlah sebuah kotak yang 

akan kita gunakan untuk menjebak objek.



2. Insert layer 2 dan berinama partikel. Pada frame 1 buatlah sebuah objek 

berbentuk lingkaran. Setelah selesai ubahlah objek tersebut menjadi tipe 

movieclip dan berilah nama dengan partikel_mc



3. Insert layer Script dan tuliskan actionScript seperti di bawah ini

var laju_x:Number=-50;

var laju_y:Number=-50;

partikel_mc.onEnterFrame=function(){

this._x+=laju_x;

if(this._x>400 or this._x<120){

laju_x=-laju_x;

}

this._y+=laju_y;

if(this._y>270.8 or this._y<60.8){

laju_y=-laju_y;



}

}

Menggerakkan objek dengan tombol

Pada bagian ini kita akan belajar tentang bagaimana untuk memindahkan 

suatu objek dengan menggunakan tombol panah kiri, kanan, atas dan bawah. Untuk 

lebih jelasnya ikutilah langkah-langkah beikut ini.

1. Buat satu layer bernama gambar. Import gambar ke stage dengan cara pilih File 

> Import > Import to Stage.



2. Insert layer dan beri nama objek. Dari layer ini buatlah seuah objek, misalnya 

balon dan jadikan menjadi bentuk movieclip. Berilah nama objek tersebut 

dengan balon_mc.

3. Buat layer teks. Tempatkan dynamic teks di tempat tertentu dan berilah nama 

dengan informasi_text.

4. Insert layer satu lagi bernama Script. Pada frame 1 tuliskan script seperti di 

bawah ini.

informasi_text.text="Gunakan tombol anak panah untuk menggerakkan 

balon";



var laju:Number=10;

balon_mc.onEnterFrame=function(){

if (Key.isDown(Key.RIGHT)){

this._x+=laju;

}

if (Key.isDown(Key.LEFT)){

this._x-=laju;

}

if (Key.isDown(Key.UP)){

this._y-=laju;

}

if (Key.isDown(Key.DOWN)){

this._y+=laju;

}

}

Membuat Efek 3 dimensi.

Dengan mengatur pada bagian properties objek dengan action script maka kita 

dapat membuat kesan bahwa sebuah objek adalah 3 dimensi. Caranya adalah



1. Masukkan gambar logo UNY.

2. Jadikan objek tersebut menjadi movieclip. Kemudian dengan select pada objek, 

tuliskan perintah sebagai berikut

onClipEvent(load){

n=5;

}

onClipEvent(enterFrame){

this._xscale+=n

if (this._xscale>100 or this._xscale<-100){

n=-n;

}

}

Kita dapat pula memberikan action pada frame. Caranya klik frame 1 layer 



Script dan berikan script seperti di bawah ini

var laju:Number=5;

uny_mc.onEnterFrame=function(){

this._xscale+=laju;

if (this._xscale>100 or this._xscale<-100){

laju=-laju;

}

}

Membuat animasi putar

Animasi putar sangat mudah dibuat dengan actionScript. Inilah langkah-

langkahnya.

1. Buatlah layer objek. Buatlah sebuah lingkaran seperti terlihat dibawah ini. 

Jangan lupa jadikan menjadi bentuk movieclip. Berilah nama objek tersebut 

dengan lingkaran_mc. Untuk memperoleh lingkaran yang benar-benar bulat, 

caranya sambil membuat lingkaran tekan tombol Shift. Tambahan lagi, agar 

objek kelihatan perputarannya maka hapus sedikit bagian samping lingkaran. 

Lihat ganbar di bawah ini.



2. Insert layer Script. Berikan script pada frame 1 layer script.

var laju:Number=5;

lingkaran_mc.onEnterFrame=function(){

this._rotation+=laju;

}

Fungsi startDrag dan stopDrag

Fungsi startDrag sangat penting manakala kita menginginkan objek dapat 

diseret ke manapun kita suka. Untuk menggambarkan penggunaan fungsi tersebut, 

marilah kita ikuti langkah-langkah berikut ini

1. Buat layer 1 bernama objek. Di layer ini buatlah objek sembarang berbentuk 

movieclip dan berilah nama objek_mc.

2. Insert layer dan berinama Script. Sekarang tuliskan script seperti di bawah ini

objek_mc.onPress=function(){



startDrag("objek_mc",true);

}

objek_mc.onRelease=function(){

objek_mc.stopDrag();

}

Membuat Animasi Sinusoidal

Untuk membuat animasi berupa grafik sinus dapat kita lakukan dengan cara 

sebagai berikut:

1. Buat layer Scrip dan buatlah seperti di bawah ini

lineStyle(1,0x000000, 100);

moveTo(0,100);

a=50; //amplitudo

b=50; //frekuensi

for(x=1;x<500;x++){

y=a*Math.sin(b*x);

lineTo(x,y+200)

trace("x="+x+";y="+y);

}



ANIMASI WARNA

Untuk  membuat  animasi  warna  dapat  dilakukan dengan langkah-langkah sebagai 

berikut.

1. Ikuti langkah1 hingga 3 pada trik animasi gerak sebelumnya.

2. Berikan script pada objek sebagai berikut.

onClipEvent(load){
i=10;

}
onClipEvent(enterFrame){

_alpha=_alpha+i;
if (_alpha>100 or _alpha<0){

i=-i;
}

}
Keterangan

Scrip di atas akan menghasilkan animasi warna, dimana ketika warna objek mencapai 

100% maka sedikit demi sedikit hingga menghilang. Setelah itu akan muncul kembali 

hingga warna alpha 100%. Demikian proses ini berulang-ulang.

MEMBUAT ANIMASI SKALA 

Untuk  membuat  animasi  skala  pada  objek  dapat  dibuat  dengan  memperhatikan 



property objek bernama _xscale untuk skala arah sumbu x dan _yscale untuk skala 

arah sumbu y. Lebih jelasnya ikuti langkah berikut ini.

1. Ikuti langkah1 hingga 3 pada trik animasi gerak sebelumnya.

2. Berikan script pada objek sebagai berikut.

onClipEvent(load){
i=10;

}
onClipEvent(enterFrame){

_xscale=_ xscale +i;
if (_xscale>100 or _scale <-100){

i=-i;
}

}

TOMBOL MENGENDALIKAN MOVIE CLIP

Adakalnya tombol dapat digunakan untuk mengendalikan pergerakan sebuah 

objek movie clip. Agar memudahkan pekerjaan kita, kita tidak perlu membuat tombol 

sendiri,  melainkan  langsung  menggunakan  yang  sudah  disediakan  oleh  Flash  di 

librarynya.  Caranya klik menu  Window ->  Other Panels  ->  Common Libraries -> 

Button. Selengkapnya ikuti langkah-langkah berikut ini

1. Buat  objek  lingkaran  bertipe  movie  clip  dan  berinama  objek  tersebut 

movie_mc.



2. Klik menu  Window -> Other Panels -> Common Libraries -> Buttons  untuk 

memperoleh  tombol  yang kita  inginkan.  Dalam tutorial  ini  kita  ambil  jenis 

tombol Key Buttons. 

3. Selanjutnya seret tombol-tombol yang muncul di jendela Library Buttons. 



4. Untuk memberikan scrip pada setiap tombol, maka aktiftkan terlebih dahulu 

(pilih) objek dan selanjutnya masuk ke jendela Action.

5. Selengkapnya  inilah  script  yang  diberikan  pada  setiap  tombol  untuk 

mengendalikan objek lingkaran.

• TOMBOL KIRI

on(release){
movie_mc._x = movie_mc -5;

}
• TOMBOL KANAN

on(release){
movie_mc._x = movie_mc +5;

}

• TOMBOL ATAS

on(release){
movie_mc._y = movie_mc -5;

}
• TOMBOL BAWAH

on(release){
movie_mc._y = movie_mc +5;

}



ANIMASI PUTAR DENGAN ACTION SCRIPT

Untuk membuat  animasi  putar mengelilingi  poros tertentu,  maka dapat  dilakukan 

dengan langkah-langkah berikut ini.

1. Ikuti langkah1 hingga 3 pada trik animasi gerak sebelumnya.

2. Berikan script pada objek sebagai berikut.

onClipEvent(load){
i=5;

}
onClipEvent(enterFrame){

_rotation=_rotation+i;
}

MEMBUAT TOMBOL UNTUK NAVIGASI KE MATERI E-LEARNING

Untuk membuat tombol navigasi ke materi-materi e-learning dapat dilakukan 



dengan cara sebagai berikut.

1. Buatlah  tombol-tombol  navigasi  antara  lain  Home,  Materi,  Evaluasi, 

Kesimpulan,  Umpan  Balik.  Cara  untuk  membuat  tombol-tombol  navigasi 

dapat dilihat kembali pada materi tutorial tentang pembuatan tombol.

2. Klik frame 20 pada layer 2 dan insert Frame.

3. Buat layer bernama Isi.

4. Pada  frame  1  layer  Isi  Isikan  tulisan  ‘INI  ADALAH  HOME’,.  Kemudian 

masukkan  keyframe  pada  frame  5  dan  tuliskan  ‘INI  ADALAH  MATERI’. 

Pada  frame  10  masukkan  keyframe  dan  buatla  tulisan  ‘INI  ADALAH 

EVALUASI’ dan terakhir pada frame 15 masukkan keyframe dan buat tulisan 

‘INI ADALAH KESIMPULAN’.



5. Buatlah layer satu lagi bernama Script.

6. Pada frame 1 layer scrip berilah action

Stop();

7. Aktifkan tombol Home dan beri scrip

on(release){

gotoAndStop(1);

}

8. Aktifkan tombol Materi dan beri scrip

on(release){

gotoAndStop(5);

}

9. Aktifkan tombol Evaluasi dan beri scrip

on(release){



gotoAndStop(10);

}

10. Aktifkan tombol Kesimpulan dan beri scrip

on(release){

gotoAndStop(15);

}

11. Tekan ctrl + Enter untuk melihat hasilnya



BAB VI

PENGENALAN KOMPONEN FLASH MX 2004

Macromedia  Flash  MX  2004  menyediakan  fitur  yang  lebih  lengkap  dibandingkan 

dengan  Flash  generasi  sebelumnya.  Kelengkapan  komponen  dasar  untuk  tujuan 

pembuatan  evaluasi  elearning  dapat  dengan  mudah  digunakan.  Untuk  lebih 

memberikan  kejelasan  tentang  materi  ini,  maka  marilah  kita  bahas  satu  per  satu 

komponen dasar yang disediakan olehFlash MX 2004.

Dalam tutorial ini tidak akan dibahas secara mendetail kegunaan komponen 

dalam flash. Akan tetapi, hanay akan didikenalkan beberapa komponen yang biasa 

digunakan dalam pembuatan e-learning.

1. Komponen Button

KOmponen  button  memiiki  user  interface  (tampilan)  tersendiri  dengan 

rancangan khusus pada property inspector. Untuk menggunakan komponen button, 

maka ikuti langkah-langkah berikut ini

5. Ambil  komponen  button  dari  Panel  Componentbagian  UI  Cmponents  dan 

letakkan di  stage.  Jadi  setiap kali  kita membutuhkan komponen,  kita selalu 

mengambilnya dari bagian ini.



5. Setelah itu komponen button akan muncul bagian library bernama Button dan 

komponen yang ada di stage akan menjadi instance.

5. Ambil  kembali  dari  library  jika  kita  menginginkan  kembali  lebih  dari  satu 

komponen button.

5. Ketika  kita  mengklik  instance  component,  maka  akan  muncul  Component 

Inspector seperti di bawah ini.



Beberapa keterangan dari Component Inspector antara lain

• Icon,  menambahkan  icon  tambahan  pada  tombol.  Kita  bias 

menambahkan symbol movieclip atau grafik, kemudian isi linkagenya 

pada library.

• Label, tulisan yang muncul di atas tombol

• labelPlacement,  memberikan  pilihan  apakah  tulisan  rata  kiri,  kanan, 

atas, bawah atau bawah tombol.

• Toggle,  jika  bernilai  true  maka  tombol  akan  tetap  dalam  keadaan 

ditekan (warna hijau)

• Selected, jika toggle bernilai true maka parameter ini mengecek apakah 

tombol ditekan (true)  atau dilepas (false).  Oleh karena itu, toggle dan 

selected bekerja berpasangan.

Contoh

Buatlah  dua  buah  tombol  dengan   nama  instance  tombol1_btn  dan 

tombol1_btn. Selanjutnya klik di frame 1 dan berikan script seperti di bawah ini untuk 

memanipulasi property inzpectornya.

tombol1_btn.onRelease=function(){

trace("tombol1");

trace(this.toggle);

trace(this.selected);

}

tombol2_btn.onRelease=function(){

trace("tombol2");

trace(this.toggle);



trace(this.selected);

}

2. Komponen CheckBox

Komponen ini juga berguna untuk membuat soal cek poin. Setelah salah satu 

opsi  dipilih,  selanjutnya dapat  diberikan umpan balik  langsung dengan mengecek 

kebenaran jawaban.

Contoh. Misalnya diberikan pertanyaan 

Siapakah orang pertama kali yang samapai di bulan ?

a. Einstein

b. Eddison

c. Neil Amstrong

d. Edwin Haldrin

e. Habibi

Untuk membuat soal tersebut dalam lingkungan Flash dapat dilakukan dengan 

langkah-langkah berikut ini.

1. Buat teks berbunyi ‘Siapakah orang pertama kali yang sampai di bulan ?’ 

dengan menggunakan text tool dengan mode static text.

2. Ambil komponen checkbox dan seret ke stage.

3. Perhatikan Componet Inspectornya dan gantilah label yang ada dengan teks 

‘Einstein’.

4. Ulangi langkah ke tiga dengan label Eddison.

5. Ulangi  langkah  ke  empat  untuk  menuliskan  Neil  Amstrong,  Edwin 

Haldrin dan Habibi.

6. Berilah nama masing-masing instance dengan pil1, pil2, pil3, pil4 dan pil5.



7. Kemudian letakkan tombol button dengan nama instance tombol_btn dan 

isi labelnya dengan Cek Jawaban.

8. Setelah itu berilah script pada frame 1

tombol_btn.onRelease=function(){

if (pil1.selected or pil2.selected or pil5.selected){

trace("Pilihan anda salah. Silahkan dicoba lagi.");

}

else if (pil3.selected or pil4.selected){

trace("Pilihan anda Benar. Selamat.!!!");

}

}

Dari tampilan Flash dapat diperlihatkan seperti di bawah ini 

3. Komponen Radio Button

Komponen  radio  button  memiliki  kemiripan  dengan  komponen  check  box 

dalam hal penggunaannya. Akan tetapi ada perbedaan penggunaan. Jika check box 

kita dapat memilih lebih dari satu jawaban benar, sedangkan dengan radio button, 



jawaban benar hanya ada satu saja.

Contoh. Misalnya diberikan pertanyaan 

Siapakah orang pertama kali yang menemukan listrik ?

a. Einstein

b. Eddison

c. Neil Amstrong

d. Edwin Haldrin

e. Habibi

Untuk membuat soal tersebut dalam lingkungan Flash dapat dilakukan dengan 

langkah-langkah berikut ini.

1. Buat  teks  berbunyi  ‘Siapakah  orang  pertama  kali  yang  menemukan 

listrik ?’ dengan menggunakan text tool dengan mode static text.

2. Ambil komponen Radio Button dan seret ke stage.

3. Perhatikan Component Inspectornya dan gantilah label yang ada dengan 

teks ‘Einstein’.

4. Ulangi langkah ke tiga dengan label Eddison.

5. Ulangi  langkah  ke  empat  untuk  menuliskan  Neil  Amstrong,  Edwin 

Haldrin dan Habibi.

6. Berilah  nama masing-masing  instance  dengan  pil1,  pil2,  pil3,  pil4  dan 

pil5.

7. Kemudian letakkan tombol button dengan nama instance tombol_btn dan 

isi labelnya dengan Cek Jawaban.

8. Setelah itu berilah script pada frame 1



tombol_btn.onRelease=function(){

if (pil2.selected ){

trace("Pilihan anda Benar. Selamat.!!!");

}

else {

trace("Pilihan anda salah. Silahkan dicoba lagi.");

}

}

Dari tampilan Flash dapat diperlihatkan seperti di bawah ini 

4. Komponen Combo Box

Komponen ini digunakan untuk memilih data yang sudah pasti, misalnya data 

tentang  hari,  bulan  atau  yanglainnya.  Untuk  menggunakan  komponen  ini  ikuti 

langkah-langkah berikut ini



1. Ambil komponen Combo Box dan seret ke stage.

2. Berilah nama combobox untuk instance name nya.

3. Perhatikan Component Inspectornya dan gantilah label yang ada 

5. Untuk mengisi data pada komponen Combo Box, maka klik tanda      pada 

property data. Hasilnya 



5. Sekarang beri script di frame 1 sebagai berikut

this.onEnterFrame=function(){

trace(combobox.data[combobox.selectedIndex]);

}

Beberapa hal yang perlu diketahui dalam component inspector

• Data : array yang menunjukan nilai yang kita isikan

• Editable :  Jika bernilai  true  berarti kita dapat menganti atau mengisi teks di 

combo box.

• Label : tempat memberi teks pada komponen.

• Rouwcount :  angka berap banyak label yang bias terlihat saat di drop down 

sebelum scrollbar muncul.

5. Komponen List 

Komponen  ini  sebenarnya  mirip  dengan  komponen  combo  box,  hanya 

tampilan  yang  sedikit  berbeda.  Untuk  menggunakan  komponen  ini  ikut  langkah-



langkah berikut ini.

1. Ambil komponen List dan seret ke stage.

2. Atur component Inspectornya. Untuk data isikan nilai Einstein, Eddison, Edwin 

Haldrin, Neil Amstrong dan Habibi.

3. Untuk labels isikan Ilmuwan 1, Ilmuwan 2, Ilmuwan 3, Ilmuwan 4, Ilmuwan 5.

4. Berikan script seperti di bawah ini.

this.onEnterFrame=function(){

trace(list.data[list.selectedIndex]);

}

Dari tampilan Flash dapat diperlihatkan seperti di bawah ini 

6. Komponen TextArea

Komponen ini berguna untuk menampilkan tuliasan atau format html, lengkap 

dengan  vertical  dan  horizontal  scrollbar.  Untuk  menggunakannya  ikuti  langkah-

langkahberikut ini.

1. Ambil textArea dari list UI Component dan tempatkan di stage. Berikan nama 

instance nya : textarea.



2. Kemudian atur component inspector sebagai berikut 

 3. Berikan script sebagai beikut

textarea.text="Selamat datang di Jurusan Pendidikan Fisika";



MEMBUAT EVALUASI DENGAN RADIO BUTTON

Evaluasi dari sebuah matakuliah sangat penting dilakukan oleh seorang guru 

untuk mengetahui  hasil  proses  pembelajaran yang sudah dilakukan selama kurun 

waktu tertentu. Untuk membuat evaluasi ini dapat dilakukan dengan memanfaatkan 

komponen  Radio Button  yang sudah disediakan oleh Flash MX 2004.  untuk lebih 

jelasnya marilah kita ikuti langkah-langkah berikut ini:

1. Buatlah layer 1 untuk latar belakang halaman evaluasi kita. Berinama layer ini 

dengan nama Latar. Kemudian klik frame 11 dan insert Frame.

2. Buatlah layer 2 dengan nama  aksesoris dengan tujuan untuk mempercantik 

tampilan, misalnya dikasih bintang-bintang kecil.



3. Buatlah  layer  Pertanyaan,  dimana  disini  kita  akan  membuat  pertanyaan 

evaluasi.

4. Masih di layer Pertanyaan, klik frame 2 dan Insert Keyframe. Mulai disini kita 

akan menuliskan pertanyaan pertama yaitu

 Apakah nama planet yang letaknya paling dekat dengan matahari ?

Di bagian bawah berikan komponen Push Button dengan label Lanjut.

5. Klik frame 3 dan Insert Keyframe. Tuliskan pertanyaan kedua 

Apakah nama planet yang letaknya kedua terdekat dengan matahari ?
Di bagian bawah berikan komponen Push Button dengan label Lanjut.

6. Klik frame 4 dan Insert Keyframe. Tuliskan pertanyaan kedua 

Apakah nama planet yang letaknya ketiga terdekat dengan matahari ?

Di bagian bawah berikan komponen Push Button dengan label Lanjut.



7. Klik frame 5 dan Insert Keyframe. Tuliskan pertanyaan kedua 

Apakah nama planet yang letaknya keempat terdekat dengan matahari ?

Di bagian bawah berikan komponen Push Button dengan label Lanjut.

8. Klik frame 6 dan Insert Keyframe. Tuliskan pertanyaan kedua 

Apakah nama planet yang letaknya kelima terdekat dengan matahari ?

Di bagian bawah berikan komponen Push Button dengan label Lanjut.

9. Klik frame 7 dan Insert Keyframe. Tuliskan pertanyaan kedua 

Apakah nama planet yang letaknya keenam terdekat dengan matahari ?

Di bagian bawah berikan komponen Push Button dengan label Lanjut.

10. Klik frame 8 dan Insert Keyframe. Tuliskan pertanyaan kedua 

Apakah nama planet yang letaknya ketujuh terdekat dengan matahari ?

Di bagian bawah berikan komponen Push Button dengan label Lanjut.

11. Klik frame 9 dan Insert Keyframe. Tuliskan pertanyaan kedua 

Apakah nama planet yang letaknya kedelapan terdekat dengan matahari ?

Di bagian bawah berikan komponen Push Button dengan label Lanjut.

12. Klik frame 10 dan Insert Keyframe. Tuliskan pertanyaan kedua 

Apakah nama planet yang letaknya kesembilan terdekat dengan matahari?

      Di bagian bawah berikan komponen Push Button dengan label Lanjut.

13. Klik frame 11 dan Insert Keyframe. Tuliskan ‘HASIL EVALUASI’, dynamic text 

dan button untuk mencoba lagi seperti terlihat dibawah ini. Di bagian bawah 

berikan komponen Push Button dengan label Lanjut.

14.  Buatlah layer keempat bernama  Radio.  Di layer ini kita akan menempatkan 

pilihan  jawaban yang terdiri dari nama planet, yaitu Merkurius, Venus, Mars, 

Bumi, Nepturnus, Yupiter, Saturnus, Uranus dan Pluto. 



15.  Buatlah layer kelima bernama Action

16. Klik frame 1 dan buatlah action script seperti berikut ini

rightAnswers=0;
wrongAnswers=0;

17.  Klik  frame layer  action dan masukkan keyframe,  kemudian tuliskan script 

seperti di bawah ini

stop();



function yourAnswer(component) {
thisAnswer=radioGroup.getValue();
rightAnswer=component._name;
if (rightAnswer == thisAnswer) {
rightAnswers=rightAnswers+1;
          } else {
                     wrongAnswers=wrongAnswers+1;
                   }
     yourGrade=Math.round(100*(rightAnswers/(rightAnswers+wrongAnswers)));
     gotoAndPlay(nextFrame());
          }

function tryAgain() {
gotoAndPlay(1);
 }

Membuat Preloader

Preloader adalah suatu animasi yang dibuat dengan tujuan untuk menunggu proses 

download file utama. Biasanya, jika e-learning memuat file yang besar, maka proses 



loadingnya  juga  tidak  sebentar.  Oleh  sebab  itu,  program  ini  tbertujuan  untuk 

menghindari  kebosanan dari  pengguna  e-learning  kita.  Program animasi  ini  tidak 

tidak besar dan mudah untuk dibuat. 

Untuk membuat preloader ini, mari ikuti langkah-langkah berikut ini

1. Buatlah file utama terlebih dahulu. Tentu saja file utama kita tersebut berada 

dalam Scene 1. Karena merupakan file utama e-learning, maka pembuatannya 

harus bersungguh-sungguh, apalagi kalau saudara gunakan untuk tugas akhir. 

Nah sebagi contoh mudah, kita gunakan yang sudah ada bersama di Flash 2004 

yaitu file Quiz.

2. Tambahkan scene  baru. Caranya klik insert > Scene. Untuk melihat scene yang 

sudah anda buat, klik Window > Design Panels > Scene.

 



3. Ubahlah nama scene yang baru anda buat dengan nama  preloader.  Caranya 

klik dua kali, kemudian beri nama baru.

4. Drag / seret scene preloader yang baru anda buat diatas scene 1.  Tujuannya 

agar scene preloader tersebut dijalankan lebih dulu ketimbang file utama kita 

dan ltu tujuan kita.



5. Pada scene preloader ini buatlah teks  “ LOADING …” dan ubahlah menjadi 

simbul grafik agar nanti dapat dianimasikan.

6. Masukkan  keyframe  di  frame  30  dan  atur  properties  untuk  teks  tersebut, 

misalnya  warnanya  menjadi  hitam.  Caranya,  klik  frame  30,  klik  teks  yang 

sudah menjadi grafis tersebut dan pada bagian color > tint pilih warna hitam.

7. Letakkan kursor diantara frame 1 dan frame 30, dan berikan tween motion.

8. Buat layer baru diatas layer teks loading. Klik rectangule tool untuk membuat 

kotak.  Agar  lebih  manis  berikan  harga  bukan  nol  pada  radius  cornernya 

(misalnya 20). Buatlah kotak di bawah teks loading.



9. Masukkan keyframe pada frame 30. Kembali ke frame 1, buatlah bentuk kotak 

tersebut width menjadi  kecil.  Caranya anda boleh melihat bagian properties 

dan pada bagian width berikan harga sama dengan 2.

10. Letakkan kursor berada diantara frame 1 dan 30 dan berikan Shape Tween.



PENGEMBANGAN MEDIA PEMBELAJARAN

MEMBUAT EVALUASI

Evaluasi merupakan hal sangat penting untuk menguji seberapa dalam materi 

yang yang sudah dikuasi oleh siswa. Untuk membuat evaluasi sederhana dengan 

flash, maka dapat dilakukan dengan cara sebagai berikut.

STEP 1

1. Atur ukuran layar yang akan digunakan untuk menampilkan media ini. 

Biasanya ukurannya adalah 800 pixel x 600 pixel. Lihat bagian properties.

2. Buat layer dengan nama bacground untuk menempatkan warna latar yang kita 

inginkan. Pada frame 10, klik kanan kemudian pilih Insert frame. Pada layer ini 

pilihlah warna latar yang diinginkan.

3. Buat layer dua bernama kotak. Secara otomatis panjang frame pada layer kotak 

mengikuti  panjang  frame  layer  sebelumnya.  Pada  frame  2,  klik  kanan  dan 



insert keyframe. Sekarang buatlah kotak untuk menempatkan soal yang akan 

diujikan.

4. Buat  layer  soal.  Pada  frame  1,  buatlah  tulisan  “INI  ADALAH  PETUNJUK 

MENGERJAKAN SOAL”. Pada frame 2 insert keyframe dan hapus tulisan “INI 

ADALAH  PETUNJUK  MENGERJAKAN  SOAL”.  Sekarang  dapat  mulai 

membuat soal.

5. Pada frame 2 layer soal tuliskan 'INI SOAL NOMOR 1' yang ditempatkan di 

atas kotak membuat soal. Kemudian dibawah kotak tempatkan tombol-tombol 

pilihan A, B dan C. Dimisalkan jawaban yang benar adalah A. Lihat gambar 

dibawah. 



6. Pada frame 3 layer soal tuliskan 'INI SOAL NOMOR 2' yang ditempatkan di 

atas kotak membuat soal. Kemudian dibawah kotak tempatkan tombol-tombol 

pilihan A, B dan C. Dimisalkan jawaban yang benar adalah B. Demikian 

seterusnya sampai berapa soal yang diinginkan.

7. Pada frame 5 layer soal tuliskan Hasil Evaluasi. Dibawah tulisan tersebut 

tuliskan Benar, Salah dan Prosentase. Disamping tulisan tersebut masukkan 



dynamic text dan variabel masing-masing dynamic text berilah nama benar, 

salah dan prosentase.

8. Buat layer Tombol. Pada frame 1 masukkan tombol Next dan Back (untuk lebih 

mudahnya, ambil saja dari Library. Kalau button library belum ada, maka 

dapat kita tampilkan dengn cara pilih Window > Common Libraries > Buttons. 

Selanjutnya akan tertampil pilihan-pilihan tombol yang dapat kita ambil. 

Tempatka tombol tersebut di kanan bawah. Berilah nama tombol tersebut 

dengan 'next_btn' yang disikan pada bagian instant name.



9. Buatlah satu layer lagi bernama Script. Di dalam layer Script ini nanti kita akan 

tempatkan action script untuk media ini.

STEP 2

1. Pada frame 1 layer Script, tuliaskan script seperti dibawah ini.

stop();

benar=0;

salah=0;

next_btn._visible=true;

back_btn._visible=false;

2. Pada frame 2 insert keyframe dan berikan script 

next_btn._visible=false;

3. Pada frame 5 layer script insert keyframe dan tuliskan script seperti di bawah 



ini.

back_btn._visible=true;

prosentase=benar/(benar+salah)*100;

3. Arahkan pointer pada layer soal. Pada frame 2, yaitu tempat soal nomor 1, 

berikan action script pada tombol A_btn dengan

on(release){

benar=benar+1;

nextFrame();

}

Berikan action script pada tombol B_btn dengan

on(release){

salah=salah+1;

nextFrame();

}

Berikan action script pada tombol C_btn dengan

on(release){

salah=salah+1;

nextFrame();

4. Masih di layer soal, sekarang berikan action script seperti dibawah ini



 Berikan action script pada tombol A_btn dengan

on(release){

salah=salah+1;

nextFrame();

}

Berikan action script pada tombol B_btn dengan

on(release){

benar=benar+1;

nextFrame();

}

Berikan action script pada tombol C_btn dengan

on(release){

salah=salah+1;

nextFrame();

5. Arahkan pointer pada layer Tombol. Klik pada tombol next_btn dan berikan 

action script seperti di bawah ini

on(release){

nextFrame();

}



6. Masih di layer Tombol dan select tombol back_btn, kemudian berikan action 

berikut

on(release){

gotoAndPlay(1);

}

MEMBUAT MEDIA PEMBELAJARAN SEDERHANA

Pada pasal ini kita akan membuat media pembelajaran sederhana yang terdiri 

atas ruang untuk menampilkan deskripsi konten dan tombol navigasi untuk menuju 

ke konten. Untuk lebih jelasnya ikuti langkah-langkah berikut ini

1. Buatlah layer background, kemudian pilihlah bacground sesuai dengan 

keinginan anda. Kemudian pada frame 6 insert frame.

2. Buatlah layer kotak untuk menempatkan tombol navigasi dan deskripsi konten.



3. Buatlah layer tombol. Pada layer tombol ini buatlah tombol dan tempatkan di 

atas kotak tombol dibawah menu yang sudah disediakan.



4. Buatlah layer deskripsi. Pada frame 1 tuliskan 'INI ADALAH HALAMAN 

INTRO'. Insert keyframe pada frame 2 dan tuliskan 'INI ADALAH HALAMAN 

MATERI'. Insert keyframe pada frame 3 dan tuliskan 'INI ADALAH 

HALAMAN LATIHAN'. Insert keyframe pada frame 4 dan tuliskan 'INI 

ADALAH HALAMAN EVALUASI'. Insert keyframe pada frame 5 dan tuliskan 

'INI ADALAH HALAMAN GLOSARY'. Insert keyframe pada frame 6 dan 

tuliskan 'INI ADALAH HALAMAN PROFIL'.

5. Buatlah layer Script. Pada frame 1 tuliskan script

stop();

6. Kembali ke layer tombol dan berikan action script pada tombol-tombol yang 

sudah kita buat. 

a) Untuk tombol Intro berikan action script

on(release){

gotoAndStop(1);

}

b) Untuk tombol Materi berikan action script

on(release){

gotoAndStop(2);

}

c) Untuk tombol Latihan berikan action script



on(release){

gotoAndStop(3);

}

d) Untuk tombol Evaluasi berikan action script

on(release){

gotoAndStop(4);

}

e) Untuk tombol Glosary berikan action script

on(release){

gotoAndStop(4);

}

f) Untuk tombol Profil berikan action script

on(release){

gotoAndStop(6);

ACTION SCRIPTS

Mempublish file Flash

Setelah kita selesai membuat semua hal mengenai media pembelajaran dengan 



flash, maka seterusnya adalah mempublish file flash yang kita miliki. Untuk 

mempublish file flash dapat dilakukan dengan cara pilih menu File > Publish Settings. 

Kemudian akan muncul jendela Publish Settings seperti di bawah ini. Kita pilih 

menjadi file apa media yang ingin kita peroleh, apakan dalam format .swf, .html, .exe 

atau yang lainnya. Akan tetapi, biasanya kita memilih format .exe agar dapat 

dijalankan secara mandiri.

Setelah dipilih format seperti yang kita inginkan, selanjutnya pilih Publish dan 

OK.



Membuat AutoRun

Apabila media pembelajaran sudah dikemas dalam sebuah cd, ketika cd kita 

masukkan dalam komputer, maka secara otomatis komputer akan langsung 

memainkan media pembelajaran yang ada di dalam cd tersebut. Untuk itu diperlukan 

penyertaan file bernama AutoRun yang disimpan dalam satu tempat dengan media 

yang kita miliki. Secript untuk Auto Run adalah sebagai berikut

[AutoRun]

open=aplikasi.exe

icon=aplikasi.ico

Setelah  dibuat  file  itu  dalam  notepad,  kemudian  simpan  file 

autoRun tersebut dengan ekstensi .inf
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